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C H A P T E R 13

Management Software FAQ

This chapter answers some of the most frequently asked questions about Cisco Fabric Manager and 
Device Manager. This chapter contains the following topics:

• Installation Issues, page 13-3

– When installing Fabric Manager from windows, why does clicking install fail?, page 13-3

– Why do I have trouble launching Fabric Manager on Solaris?, page 13-3

– What do I do if my browser prompts to save JNLP files?, page 13-3

– What do I do if I see a "Java Web Start not detected" error?, page 13-4

– What do I do if my desktop shortcuts not visible?, page 13-4

– How do I upgrade to a newer version of Fabric Manager or Device Manager?, page 13-4

– How do I downgrade Fabric Manager or Device Manager?, page 13-4

– What do I do if an upgrade is not working?, page 13-4

– What do I do if Java Web Start hangs on the download dialog?, page 13-5

– How do I manually configure a browser for Java Web Start?, page 13-5

– How do I run Java Web Start from the command line?, page 13-5

– How do I clear the Java Web Start cache?, page 13-6

– What do I do if my login does not work in Fabric Manager or Device Manager?, page 13-6

– What do I do if I cannot install Fabric Manager or Device Manager, or run Java, when 
pcAnyWhere is running?, page 13-6

– What do I do if the Fabric Manager or Performance Manager service shows up as “disabled” in 
the Services menu?, page 13-6

– What do I do if I am unable to install Fabric Manager or Device Manager, or run Java, when 
McAfee Internet Suite 6.0 Professional is running?, page 13-7

• General, page 13-7

– What do I do if I see errors while monitoring Area chart graphing?, page 13-7

– What do I do if I see "gen error" messages?, page 13-7

– What do I do if disk images in the Device Manager Summary View are not visible?, page 13-7

– What do I do if I am unable to set both the D_S_TOV and E_D_TOV timers in Device 
Manager?, page 13-7

– What do I do if columns in Device Manager tables are too small?, page 13-8
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– What do I do if fabric changes are not propagated onto the map (for example, links don't 
disappear)?, page 13-8

– What do I do if the PortChannel creation dialog becomes too small after several uses?, 
page 13-8

– What do I do if I see errors after IPFC configuration?, page 13-8

– What do I do if Fabric Manager or Device Manager is using the wrong network interface?, 
page 13-8

– What do I do if I see display anomalies in Fabric Manager or Device Manager?, page 13-8

– Why is the active zone set in edit zone always shown in bold (even after successful activation)?, 
page 13-9

– Can I create a zone with prefix IVRZ or a zone set with name nozonset?, page 13-9

– What do I do when One-Click License Install fails, and I cannot connect to the Cisco website?, 
page 13-9

– What do I do when Fabric Manager client and Device Manager cannot connect to the switch?, 
page 13-10

– How do I increase the log window size in Fabric Manager Client?, page 13-10

– When do I do when the FM Server Database fails to start or has a file locking error?, page 13-10

• Windows Issues, page 13-11

– What do I do when text fields show up too small, and I cannot enter any data?, page 13-11

– What do I do when printing causes an application crash?, page 13-11

– What do I do when Windows XP hangs (or I see a blue screen)?, page 13-11

– What do I do when Fabric Manager and Device Manager Icons Disappear?, page 13-11

– What do I do when Device Manager or Fabric Manager window content disappears in Windows 
XP?, page 13-11

– What do I do when SCP/SFTP fails when a file is copied from local machine to the switch?, 
page 13-11

• UNIX Issues, page 13-12

– What do I do when the parent Menus Disappear?, page 13-12

– What do I do when the web browser cannot find web server even it is running?, page 13-12

– How do I fix a "too many open files" error?, page 13-12

• Other, page 13-13

– How do I set the map layout so it stays after Fabric Manager restarted?, page 13-13

– What do I do when two switches show on the map, but there is only one switch?, page 13-13

– What does a red/orange/dotted line through the switch mean?, page 13-13

– How do I upgrade without losing map settings?, page 13-18

– How do I preserve historical data when moving Fabric Manager server to new host?, page 13-19

– Are there restrictions when using Fabric Manager across FCIP?, page 13-19

– How do I fix a "Please insure that FM server is running on localhost" message?, page 13-19

– How do I run Cisco Fabric Manager with multiple interfaces?, page 13-20

– How do I configure an HTTP proxy server?, page 13-21
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– How do I clear the topology map?, page 13-21

– How can I use Fabric Manager in a mixed software environment?, page 13-22

– How do I fix a "corrupted jar file" error when Launching Fabric Manager?, page 13-22

– How do I search for Devices in a Fabric?, page 13-22

– How does Fabric Manager Server licensing work?, page 13-24

– How do I manage Multiple Fabrics?, page 13-24

– How can I clear an Orange X Through a Switch caused by license expiration?, page 13-24

Installation Issues

When installing Fabric Manager from windows, why does clicking install fail?
To make sure that Java Web Start is installed properly, follow these steps:

Step 1 Go to the Programs menu and see if Java Web Start is there.

Step 2 Start the Java Web Start program to make sure there is no problem with the Java Runtime installation.

Step 3 Click the Preferences tab, and make sure the proxies settings are fine for Web Start.

Step 4 Check that your browser is set up to handle JNLP settings properly (see the “How do I manually 
configure a browser for Java Web Start?” section on page 13-5). 

If you had older versions of the application and you see an error pop-up window saying cannot open the 
JNLP file (in the error details), this could be because the Java Web Start cache is messed up. To work 
around this, clear the cache and retry. To clear the cache, see the “How do I clear the Java Web Start 
cache?” section on page 13-6.

Why do I have trouble launching Fabric Manager on Solaris?
If you are using Solaris 2.8 and are logged in as root and are using Netscape Navigator 6, you will not 
be able to register the mime-type. Regular users can register the mime-type with Netscape Navigator 6 
by manually adding it. Netscape 4.x works fine for all users.

What do I do if my browser prompts to save JNLP files?
Your browser may not be set up to launch Java Web Start for JNLP mime types. Java Web Start is 
probably not installed or configured properly (see the “How do I manually configure a browser for Java 
Web Start?” section on page 13-5).
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What do I do if I see a "Java Web Start not detected" error?
If you installed Java Web Start but still see an error message (in red) saying “Java Web Start not 
detected...” on the switch home page, it could be a simple JavaScript error. We try to detect a Java Web 
Start installation by running some JavaScript code tested for Internet Explorer and Mozilla (newer 
versions). On some browsers (for example, Netscape 6.0, Opera) this code does not work properly 
although the links still work. 

• First, try clicking on the install links. 

• If that does not work, check to see if the browser helper applications settings are correct (for 
example, for Netscape 6.0 Edit > Preferences > Navigator > Helper Applications). See the “How 
do I manually configure a browser for Java Web Start?” section on page 13-5.

What do I do if my desktop shortcuts not visible?
For Windows 2000 and Windows NT, we create Program Menu entries (under a new Cisco MDS 9000 
program menu) and desktop shortcuts for Fabric Manager and Device Manager. The desktop shortcuts 
and start menu entries for Fabric Manager and Device Manager are called FabricManager and 
DeviceManager respectively. In other versions of Windows, including XP, we just create batch files on 
the desktop called FabricManager.bat and DeviceManager.bat. For UNIX, we create shell scripts called 
FabricManager.sh and DeviceManager.sh under the $HOME/.cisco_mds9000/bin directory. Note that on 
Windows, installations run under Mozilla variants of browsers, and the desktop shortcuts do not get 
created. The workaround is to manually create desktop shortcuts.

How do I upgrade to a newer version of Fabric Manager or Device Manager?
To upgrade to a newer version of Fabric Manager or Device Manager, follow these steps: 

Step 1 Close all running instances of Fabric Manager or Device Manager. 

Step 2 Point your browser at the switch running the new version and click the appropriate install link. Fabric 
Manager or Device Manager prompts you to upgrade if the switch is running a newer version. 

The installer checks your local copies and updates any newer versions of the software.

How do I downgrade Fabric Manager or Device Manager?
As of Cisco MDS NX-OS Release 4.x, downgrades are not supported through the installer. To downgrade 
Fabric Manager or Device Manager to an earlier release, you need to manually uninstall first and then 
install the previous version of Fabric Manager or Device Manager.

What do I do if an upgrade is not working?
If you are trying to upgrade because Fabric Manager or Device Manager prompted you saying that the 
switch version is higher, and the upgrade failed, it might be because your default browser settings are 
incorrect. Some error must have occurred during your last browser upgrade/install. To work around this, 
launch the browser independently and click on install. 
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On rare occasions, we have seen the upgrade happen but the version does not change. This is because of 
HTTP caching in the network. During the upgrade, HTTP requests for files on the switch get cached in 
the local machine. Even though the switch is in a higher version, the management software installed is 
at the old version. The workaround for this is to uninstall the Fabric/Device Manager, clear the Java Web 
Start cache, and then do a clean install.

What do I do if Java Web Start hangs on the download dialog?
To make sure Java Web Start is set up to access the switch in the same way your browser is set up, follow 
these steps:

Step 1 Start Java Web Start (javaws.exe or javaws). You see the Java Web Start Application Manager. 

Step 2 Choose File > Preferences > General and make sure your proxy settings are correct. For example, if 
you are using an HTTP proxy, set it up here. 

Step 3 Choose Use Browser.

Step 4 Click OK.

How do I manually configure a browser for Java Web Start?
For browsers like Opera, certain versions of Mozilla, or Konqueror, you must manually register Java Web 
Start as the helper application for the JNLP files. To do this, the data you need is: 

• Description=Java Web Start 

• File Extension=jnlp 

• Mime Type=application/x-java-jnlp-file 

• Application=path-to-javaws (e.g. /usr/local/javaws/javaws) 

After setting this up, you may need to restart the browser. If you see "Java Web Start not detected" 
warnings, you can ignore them. These warnings are based on JavaScript, and not all browsers behave 
well with JavaScript. Click on the install links to install Fabric Manager or Device Manager.

Note For Windows Users: To set up Java Web Start on *.jnlp files, select Windows Explorer > Tools > Folder 
Options > File Types. Either change the existing setting for JNLP or add one so that *.jnlp files are 
opened by javaws.exe. This executable is under Program Files\Java Web Start

How do I run Java Web Start from the command line?
If you cannot get your browser to run Java Web Start, you can still run Java Web Start from the command 
line (javaws.exe or javaws) giving it the URL of the Fabric Manager or Device Manager on the switch 
as an argument. For example, if your switch IP address is 10.0.0.1, you would use these commands to 
start Fabric Manager and Device Manager: 

javaws http://10.0.0.1/cgi-bin/fabric-manager.jnlp
javaws http://10.0.0.1/cgi-bin/element-manager.jnlp
13-5
Cisco Fabric Manager Fundamentals Configuration Guide

OL-21502-01, Cisco MDS NX-OS Release 5.x



Send  documenta t ion  comments  to  fm -doc feedback@c i sco .com

Chapter 13      Management Software FAQ
Installation Issues
How do I clear the Java Web Start cache?
To clear the Java Web Start cache, follow these steps: 

Step 1 Start the Java Web Start Application Manager (javaws.exe or javaws). 

Step 2 Go to File > Preferences > Advanced and clear the applications folder or cache. You can manually 
delete the .javaws or cache directory. On Windows this is under Documents and Settings, and on UNIX 
this is under $HOME.

What do I do if during a Fabric Manager upgrade, the installer doesn’t display a 
prompt to create a shortcut?

Clear the Java Web Start cache as described in How do I clear the Java Web Start cache? in this chapter.

What do I do if my login does not work in Fabric Manager or Device Manager?
Make sure you have done the Initial Setup Routine on the switch. Refer to the Cisco MDS 9000 Family 
Fabric Manager Fundamentals Configuration Guide. Quick checks: 

• Make sure that the management interface on the switch is up (show interface mgmt0). 

• Check whether you can connect to the management interface (ping). 

• Verify the username is valid (show snmp user). You can also add/edit the users through the CLI. 

• If you have multiple network interfaces, see the “What do I do if Fabric Manager or Device Manager 
is using the wrong network interface?” section on page 13-8

What do I do if I cannot install Fabric Manager or Device Manager, or run Java, 
when pcAnyWhere is running?

You can either stop the pcAnyWhere service and install Fabric Manager or Device Manager, or 
install/update DirectX. For more information,refer to the website at http://java.sun.com/

What do I do if the Fabric Manager or Performance Manager service shows up 
as “disabled” in the Services menu?

This could happen if:

• The service menu for Fabric Manager or Performance Manager was open during an 
uninstall/upgrade. 

• The Fabric Manager client or Device Manager was running while doing an uninstall/upgrade. 

This error happens when Windows is unable to delete a service completely. A reboot of the host should 
fix the problem.
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What do I do if I am unable to install Fabric Manager or Device Manager, or run 
Java, when McAfee Internet Suite 6.0 Professional is running?

The McAfee internet suite comes with a virus scanner, firewall, antispam, and privacy management. The 
privacy management can interfere with the Fabric Manager server-client interactions. To work around 
this you must shut down the privacy service.

General

What do I do if I see errors while monitoring Area chart graphing?
When doing the area chart graphing from the monitor window, if you move the mouse over the Area chart 
before the first data comes back, you see a java.lang.ArrayIndexOutOfBoundsException error on the 
message log from JChart getX(). This is because JChart tries to locate a value that does not exist yet. 
This might be fixed in a future version of JChart.

What do I do if I see "gen error" messages?
Usually a "gen error" means that the SNMP agent on the switch had an unexpected error in the process 
of serving an SNMP request. However, when you are accessing the switch through a VPN connection or 
any sort of NAT scheme, all errors are reported as gen error. This is a known problem and will be fixed 
in a future release. You can verify whether this was the reason behind your gen error by trying to 
reproduce this error in an environment where there is no network address translation (where you are on 
the same network as the switch). 

What do I do if disk images in the Device Manager Summary View are not 
visible?

On some occasions the Summary View table in the Device Manager does not show the icons for disks 
attached to a Fx port. This is because the FC4 features are empty for this port. A LUN discovery must 
be issued to discover information about these hosts/disks that do not register their FC4 types. You can 
do this in the Device Manager by clicking FC > Advanced > LUNs.

What do I do if I am unable to set both the D_S_TOV and E_D_TOV timers in 
Device Manager?

If you modify both E_D_TOV and D_S_TOV at the same time, and the new D_S_TOV value is larger 
than the old E_D_TOV value, you will get a WrongValue error. To work around this, you must change 
the values separately.
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What do I do if columns in Device Manager tables are too small?
If Device Manager is trying to display a large table and your switch is running slowly, the table will come 
up with the tabs being hidden. To work around this, you must resize the window to see the data.

What do I do if fabric changes are not propagated onto the map (for example, 
links don't disappear)?

Fabric Manager shows that a device or port is down by displaying a red cross on that port or device. 
However, Fabric Manager does not remove any information that's already discovered. You must 
rediscover to correctly update the map.

What do I do if the PortChannel creation dialog becomes too small after several 
uses?

After several uses, the MemberList TextBox (in the PortChannel Create Window) does not display as it 
should. It changes from a long TextBox with a ComboBox for choosing ports, to a small square TextBox 
that is too small to choose ports. This is a known problem and will be fixed in a future release. To work 
around this problem, stop and restart Fabric Manager or Device Manager.

What do I do if I see errors after IPFC configuration?
When IPFC and out of band management are configured, the Device Manager might not work using 
SNMPv3 if you use the IPFC address. The workaround is either to use the management interface 
(mgmt0) address, or to use SNMPv1/v2c over IPFC.

What do I do if Fabric Manager or Device Manager is using the wrong network 
interface?

The problem happens because the underlying Java library picks a local interface arbitrarily. To work 
around this, supply a command line argument before starting the Fabric/Device Manager. In the desktop 
shortcut or shell script or batch file, add the following parameter "-Device Managerds.nmsAddress="

For example, in Windows the line looks like ".javaw.exe -Device Managerds.nmsAddress=X.X.X.X -cp 
.".

In desktop shortcuts, this length could exceed the maximum characters allowed. If this happens, delete 
the "-Dsun.java2d.ddoffscreen=false" portion to make more space. Newer versions of Fabric Manager 
(Release 1.2 and later) allow you to pick a preferred network interface.

What do I do if I see display anomalies in Fabric Manager or Device Manager?
If you see Fabric Manager or Device Manager submenus detached from menus, the mouse pointer in 
Fabric Manager Map is slow to react to mouse movement, or a wrong tooltip is displayed, these are 
display anomalies, not problems with Fabric Manager or Device Manager.
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Some older video cards exhibit these display anomalies. To fix this, first try updating the video drivers. 
If this doesn't solve the problem, replace the video card. 

What do I do if most of my Physical Attributes catagories disappear?
You have somehow turned off advanced features. Look for the check box Advanced Features in the upper 
right of the Fabric Manager screen. Check the box.

What do I do if I can’t see the Information pane?
The information pane should be in the upper half of the screen above the map in Fabric Manager. The 
map my be covering it. Drag the edge of the map window down or use the black triangles to reorganize 
the display.

Why is the active zone set in edit zone always shown in bold (even after 
successful activation)?

A member of this VSAN must be participating in IVR zoning. Because the IVR zones get added to active 
zones, the active zone set configuration is always different from the local zone set configuration with the 
same name. The zone set name is always bold.

Can I create a zone with prefix IVRZ or a zone set with name nozonset?
Do not use these special names. These names are used by the system for identifying IVR zones. 

What do I do when One-Click License Install fails, and I cannot connect to the 
Cisco website?

The one-click license install tries to open an HTTP connection to the Cisco website. If you do your 
browsing using an HTTP proxy then the following command- line variables need to be added to your 
Fabric Manager client scripts: 

-Dhttps.proxyHost and -Dhttps.proxyPort. 

In case your one-click install URL starts with "http://" (and not "https://"), the variables are:

-Dhttp.proxyHost and -Dhttp.proxyPort.

For example, in Windows, edit the MDS 9000\bin\FabricManager.bat file and add to the JVMARGS 
"-Dhttps.proxyHost=HOSTADDRESS -Dhttps.proxyPort=HOSTPORT". 
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What do I do when Fabric Manager client and Device Manager cannot connect 
to the switch?

Fabric Manager or Device Manager using SNMPv3 at Cisco MDS SAN-OS Release 1.3(3) or earlier 
can't manage a switch running Release 1.3(4) or later. This might affect a software upgrade using Fabric 
Manager from Release 1.3(3) to Release 1.3(4).

How do I increase the log window size in Fabric Manager Client?
To limit the memory usage by FM Client, the log window is limited to 500 lines by default. If you want 
to increase this, edit sm.properties in < install directory>/db/<user> directory and change 
LogBufferSize.

When do I do when the FM Server Database fails to start or has a file locking 
error?

In the database log (FMPersist.log) you will see an error message "The database is already in use by 
another process". The HsqlDB 1.7.1 version has this problem. The file lock problem seems to happen 
occasionally, and can be resolved by shutdown and restart of the db server. On windows this can be done 
by stopping and starting the FMPersist service and on Unix just run the FMPersist.sh script with the 
argument restart. 

How do I re-synchronize Fabric Manager Client with Fabric Manager Server?
On some occasions, when the Fabric Manager Client in not in sync with the Fabric Manager Server, you 
may need to re-synchronize the client and server. To re-synchronize Fabrix Manager Client with Fabric 
Manager Server, click Resync All Open Fabrics from the File menu,

How do I rediscover the current fabric?
When the Fabric Manager Server is not in sync with the switches in the fabric, you may need to initiate 
an on- demand discovery to update the Fabric Manager Client with the most recent changes from the 
switches in the fabric. To rediscover the fabric switches, click Rediscover from the File menu.

How do I rediscover SCSI Targets?
When the Fabric Manager Server is not in sync with the SCSI Target switches in the fabric, you may 
need to initiate an on- demand discovery to update the Fabric Manager Client with the most recent 
changes from the SCSI Target switches in the fabric. To rediscover the fabric switches, click Rediscover 
SCSI Targets from the File menu.
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Windows Issues

What do I do when text fields show up too small, and I cannot enter any data?
When Reflection X is running, certain text fields in the Fabric Manager and Device Manager are not 
rendered to the full width of the field. Resize the dialog box to see the text fields properly.

What do I do when printing causes an application crash?
On Windows NT there is a known Sun JVM bug - the printservice crashes the VM. The solution 
suggested by Sun is to update NT with SP 6. For more details refer to: 
http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=4530428.

What do I do when Windows XP hangs (or I see a blue screen)?
Windows XP with the ATI Radeon AGP graphics cards has known to freeze (hang) when a Java 
application exits. The newer drivers from ATI seem to have fixed this problem. The other workaround is 
to run the application with "-Dsun.java2d.noddraw=true". We do this today in the shortcut and shell 
scripts we create. For more details refer to: 
http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=4713003. 

What do I do when Fabric Manager and Device Manager icons disappear?
On certain versions of Windows, certain images disappear. This is a Java bug. We have a workaround 
that is already in place (disable DirectDraw acceleration) - but there are still cases where this problem 
might arise. For more details refer to: http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=4664818.

What do I do when Device Manager or Fabric Manager window content 
disappears in Windows XP?

Device Manager or Fabric Manager main window content disappears in Windows XP due to a Java bug. 
Refer to the following website:
 http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=4919780. 

 Minimize or maximize the window and restore to the normal size to restore the window content. 
Disabling Direct Draw may also prevent this from happening by adding "-Dsun.java2d.noddraw=true" 
to JVMARGS in <FM-install-dir>/bin/FabricManager.bat and DeviceManager.bat

What do I do when SCP/SFTP fails when a file is copied from local machine to 
the switch?

If there are embedded spaces in the file path, then windows scp/sftp might fail. You will get a 
copyDeviceBusy error from the switch. In tools such as the License Wizard either make sure tftp copy 
can be done or pick filenames with no spaces.
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UNIX Issues

What do I do when the parent menus disappear?
Displaying a submenu may occasionally cause the parent menu to disappear. For more details on this 
bug, refer to: http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=4470374. 

What do I do when the web browser cannot find web server even it is running?
This can happens when web browser uses proxy server. To check that for Internet Explorer, choose tools 
in menu, then choose internet options, then choose connection subpanel, then click Lan Setting. A dialog 
comes up, verify the proxy setting. 

How do I fix a "too many open files" error?
If you are running the JVM (Java Virtual Machine) on Linux and the drive where Java is installed or your 
home directory is NFS mounted, there is an open bug against the Sun JDK about errors acquiring file 
locks. The symptoms for the Fabric Manager are that launching a Device Manager or saving/opening 
files will fail, giving a "too many open files" I/O or socket exception. The JVM keeps trying to open a 
file on the NFS mounted drives, fails, and keeps trying to do it until it hits the 1024 file descriptors limit. 
Workarounds (assuming /tmp is a local disk - replace it with your tmp area): 

• System Preferences

Make sure the system level preferences are stored on a local disk. The system preferences are stored 
in $JAVA_HOME/.systemPrefs where JAVA_HOME is where you have installed the JDK. If this 
directory is NFS mounted, then just do the following:

$ rm -rf $JAVA_HOME/.systemPrefs<
$ mkdir /tmp/.systemPrefs
$ ln -s /tmp/.systemPrefs $JAVA_HOME/.systemPrefs

The problem with this workaround is that you have to make sure /tmp/.systemPrefs exists on every 
box where you are using $JAVA_HOME. We recommend installing the JVM as root and on a local 
disk. 

• User Preferences

If your home directory is NFS mounted and you are getting this problem. Do the following:

$ rm -rf $HOME/.java
$ mkdir /tmp/.java.$USER
$ ln -s /tmp/.java.$USER $HOME/.java

For further details, see the following URLs:
http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=4673298
http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=4635353 
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How do I set the map layout so it stays after Fabric Manager restarted?
If you have arranged the map to your liking and would like to “freeze” the map so that the objects stay 
as they are even after you stop Fabric Manager and restart it again, follow these steps:

Step 1 Right-click in a blank space in the map. You see a menu.

Step 2 Select Layout > Fix All Nodes from the menu.

What do I do when two switches show on the map, but there is only one 
switch?

If two switches show on your map, but you only have one switch, it may be that you have two switches 
in a non-contiguous VSAN that have the same Domain ID. Fabric Manager uses <vsanId><domainId> 
to look up a switch, and this can cause the fabric discovery to assign links incorrectly between these 
errant switches.

The workaround is to verify that all switches use unique domain IDs within the same VSAN in a 
physically connected fabric. (The fabric configuration checker will do this task.)

What does a red/orange/dotted line through the switch mean?
If a red line shows through your switch, this means Fabric Manger sees something wrong with the 
switch. Choose Switches in the Physical Attributes pane to see a status report in the information pane. 
A module, fan, or power supply has failed or is offline and plugged in.

If a dotted orange line shows through your switch, this indicates a minor status warning for that switch. 
Usually it means an issue with one of the modules. The tooltip should say exactly what is wrong. Hold 
the mouse over the switch to see the tooltip.

Below are tables of color settings and tooltip definitions for Fabric Manager and Device Manager.

Table 13-1 Fabric Manager and Device Manager Color Definitions

Fabric Manager Color Definition

Red Slash Cannot communicate with a switch via SNMP.

Red X Cannot communicate with or see a switch in the 
Domain Manager/Fabric Configuration Server list 
of fabric switches.

Device Manager Color Definition

Green Square with Mode (e.g., F, T, TE, U/I for 
FICON)

Port up.

Orange Square with Mode Trunk incomplete.
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Orange Cross Ols or Nos received.

Brown Square Port is administratively down.

Light Gray Square Port is not manageable.

Red Cross HardwareFailure/LoopbackDiagFailure/LinkFail
ure

Red Square Any other kind of configuration failure.

No Square or Black Square Port not yet configured.

Table 13-2 Device Manager Tooltip Definitions

Tooltip Definition

adminDown The port is administratively down.

bitErrRTThresExceeded Bit error rate too high.

bundleMisCfg Misconfiguration in PortChannel membership 
detected.

channelAdminDown This port is a member of a PortChannel and that 
PortChannel is administratively down.

channelConfigurationInProgress This port is undergoing a PortChannel 
configuration.

channelOperSuspended This port is a member of a PortChannel and its 
operational parameters are incompatible with the 
PortChannel parameters.

deniedDueToPortBinding Suspended due to port binding.

domainAddrAssignFailureIsolation The elected principal switch is not capable of 
performing domain address manager functions so 
no Nx_port traffic can be forwarded across 
switches, hence all Interconnect_Ports in the 
switch are isolated.

domainInvalidRCFReceived Invalid RCF received.

domainManagerDisabled Domain manager is disabled.

domainMaxReTxFailure Domain manager failure after maximum retries.

domainOtherSideEportIsolation The peer E port is isolated.

domainOverlapIsolation There is a overlap in domains while attempting to 
connect two existing fabrics.

elpFailureClassFParamErr Isolated for ELP failure due to class F parameter 
error.

elpFailureClassNParamErr Isolated for ELP failure due to class N parameter 
error.

elpFailureInvalidFlowCTLParam Isolated for ELP failure due to invalid flow 
control parameter.

Table 13-1 Fabric Manager and Device Manager Color Definitions (continued)

Fabric Manager Color Definition
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elpFailureInvalidPayloadSize Isolated for ELP failure due to invalid payload 
size.

elpFailureInvalidPortName Isolated for ELP failure due to invalid port name.

elpFailureInvalidSwitchName Isolated for ELP failure due to invalid switch 
name.

elpFailureInvalidTxBBCredit Isolated for ELP failure due to invalid transmit 
B2B credit.

elpFailureIsolation During a port initialization the prospective 
Interconnect_Ports find incompatible link 
parameters.

elpFailureLoopbackDetected Isolated for ELP failure due to loopback detected.

elpFailureRatovEdtovMismatch Isolated for ELP failure due to R_A_TOV or 
E_D_TOV mismatch.

elpFailureRevMismatch Isolated for ELP failure due to revision mismatch.

elpFailureUnknownFlowCTLCode Isolated for ELP failure due to invalid flow 
control code.

ePortProhibited Port down because FICON prohibit mask in place 
for E/TE port.

eppFailure Trunk negotiation protocol failure after maximum 
retries.

errorDisabled The port is not operational due to some error 
conditions that require administrative attention.

escFailureIsolation During a port initialization the prospective 
Interconnect_Ports are unable to proceed with 
initialization as a result of Exchange Switch 
Capabilities (ESC).

fabricBindingDBMismatch  fabric bindingactive database mismatch with 
peer.

fabricBindingDomainInvalid Peer domain ID is invalid in fabric binding active 
database.

fabricBindingNoRspFromPeer Fabric binding no response from peer.

fabricBindingSWWNNotFound Peer switch WWN not found in fabric binding 
active database.

fcipPortAdminCfgChange FCIP port went down due to configuration 
change.

fcipPortKeepAliveTimerExpire FCIP port went down due to TCP keep alive timer 
expired.

fcipPortMaxReTx FCIP port went down due to max TCP 
retransmissions reached the configured limit.

fcipPortPersistTimerExpire FCIP port went down due  to TCP persist timer 
expired.

Table 13-2 Device Manager Tooltip Definitions (continued)

Tooltip Definition
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fcipPortSrcAdminDown FCIP port went down because the source ethernet 
link was administratively shutdown.

fcipPortSrcLinkDown FCIP port went down due to ethernet link down.

fcipSrcModuleNotOnline FCIP port went down due to source module not 
online.

fcipSrcPortRemoved FCIP port went down due to source port removal.

fcotChksumErr FSP SPROM checksum error.

fcotNotPresent SFP (GBIC) not present.

fcotVendorNotSupported FSP (GBIC) vendor is not supported.

fcspAuthenfailure Fibre Channel security protocol authorization 
failed.

ficonBeingEnabled FICON is being enabled.

ficonNoPortnumber No FICON port number.

ficonNotEnabled FICON not enabled.

ficonVsanDown FICON VSAN is down.

firstPortNotUp In a over subscribed line card, first port cannot be 
brought up in E mode when the other ports in the 
group are up.

firstPortUpAsEport In a over subscribed line card, when the first port 
in a group is up in E mode, other ports in that 
group cannot be brought up.

hwFailure Hardware failure.

incomAdminRxBBCreditPerBuf Disabled due to incompatible admin port 
rxbbcredit, performance buffers.

incompatibleAdminMode Port admin mode is incompatible with port 
capabilities.

incompatibleAdminRxBBCredit Receive BB credit is incompatible.

incompatibleAdminRxBufferSize Receive buffer size is incompatible.

incompatibleadminSpeed Port speed is incompatible with port capabilities.

initializing The port is being initialized.

interfaceRemoved Interface is being removed.

invalidAttachment Invalid attachment.

invalidConfig This port has a misconfiguration with respect to 
port channels.

invalidFabricBindExh Invalid fabric binding exchange.

linkFailCreditLoss Link failure due to excessive credit loss 
indications.

linkFailCreditLossB2B Link failure when link reset (LR) operation fails 
due to queue not empty.

Table 13-2 Device Manager Tooltip Definitions (continued)

Tooltip Definition
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linkFailDebounceTimeout Link failure due to re-negotiation failed.

linkFailLineCardPortShutdown Link failure due to port shutdown.

linkFailLinkReset Link failure due to link reset.

linkFailLIPF8Rcvd Link failure due to F8 LIP received.

linkFailLIPRcvdB2B Link failure when loop initialization (LIP) 
operation fails due to non empty receive queue.

linkFailLossOfSignal Link failure due to loss of signal.

linkFailLossOfSync Link failure due to loss of sync.

linkFailLRRcvdB2B Link failure when link reset (LR) operation fails 
due to non-empty receive queue.

linkFailNOSRcvd Link failure due to non-operational sequences 
received.

linkFailOLSRcvd Link failure due to offline sequences received.

linkFailOPNyRETB2B Link failure due to open primitive signal returned 
while receive queue not empty.

linkFailOPNyTMOB2B Link failure due to open primitive signal timeout 
while receive queue not empty.

linkFailPortInitFail Link failure due to port initialization failure.

linkFailPortUnusable Link failure due to port unusable.

linkFailRxQOverFlow Link failure due to receive queue overflow.

linkFailTooManyINTR Link failure due to excessive port interrupts.

linkFailure Physical link failure.

loopbackDiagFailure Loopback diagnostics failure.

loopbackIsolation Port is connected to another port in the same 
switch.

noCommonVsanIsolation Trunk is isolated because there are no common 
vsans with peer.

none No failure.

nonParticipating During loop initialization, the port is not allowed 
to participate in loop operations

offline Physical link is in offline state as defined in the 
FC-FS standards.

ohmsExtLBTest Link suspended due to external loopback 
diagnostics failure.

other Undefined reason.

parentDown The physical port to which this interface is bound 
is down.

peerFCIPPortClosedConnection Port went down because peer FCIP port closed 
TCP connection.

Table 13-2 Device Manager Tooltip Definitions (continued)

Tooltip Definition
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How do I upgrade without losing map settings?
When you upgrade from one version of Fabric Manager to another, there is a way to prevent the loss of 
map settings (enclosure names, placement on the map, etc.)

peerFCIPPortResetConnection Port went down because the TCP connection was 
reset by the peer FCIP port.

portBindFailure Port got isolated due to port bind failure.

portBlocked Port blocked due to FICON.

portChannelMembersDown No operational members.

portFabricBindFailure Port isolated due to fabric bind failure.

portGracefulShutdown Port shutdown gracefully.

portVsanMismatchIsolation An attempt is made to connect two switches using 
non-trunking ports having different port VSANs.

rcfInProgres An isolated xE_port is transmitting a reconfigure 
fabric, requesting a disruptive reconfiguration in 
an attempt to build a single, non-isolated fabric. 
Only the Interconnect_Ports can become isolated.

srcPortNotBound No source port is specified for this interface.

suspendedByMode Port that belongs to a port channel is suspended 
due to incompatible operational mode.

suspendedBySpeed Port that belongs to a port channel is suspended 
due to incompatible operational speed.

suspendedByWWN Port that belongs to a port channel is suspended 
due to incompatible remote switch WWN.

swFailure Software failure.

tooManyInvalidFLOGIs Suspended due to too many invalid FLOGIs.

tovMismatch Link isolation due to TOV mismatch

trunkNotFullyActive Some of the VSANs which are common with the 
peer are not up.

upgradeInProgress Line card upgrade in progress.

vsanInactive Port VSAN is inactive. The port becomes 
operational again when the port VSAN is active.

vsanMismatchIsolation This VSAN is not configured on both sides of a 
trunk port.

zoneMergeFailureIsolation The two Interconnect_Ports cannot merge zoning 
configuration after having exchanged merging 
request for zoning.

zoneRemoteNoRespIsolation Isolation due to remote zone server not 
responding.

Table 13-2 Device Manager Tooltip Definitions (continued)

Tooltip Definition
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The MDS 9000/db directory contains subfolders for each user (and one for fmserver). In these subfolders 
are files for all discovered fabrics (*.dat) and maps (*.map). These are upgradable between versions. If 
you need to clear the fabric cache, you should first export the enclosures to a file to avoid losing them. 
Everything else aside from enclosures and map coordinates are stored on the switch. The preferences, 
last opened, and site_ouis.txt format doesn’t change from release to release.

How do I preserve historical data when moving Fabric Manager server to new 
host?

To preserve your data when moving Fabric Manager Server to a new host, follow these steps:

Step 1 Export the enclosures to a file.

Step 2 Reinstall Fabric Manager (if you are installing on a new host, install Fabric Manager).

Step 3 After the installation is complete, stop Fabric Manager Server. 

Step 4 Copy the RRD files from the old host to the new host. Place it in the MDS 9000 directory (on a Windows 
PC, the default installation location for this directory is C:\Program Files\Cisco Systems\DCM).

Step 5 On the new host, run PMUpgrade.bat from the MDS 9000\bin folder. This creates files and a new 
directory structure. There is a directory for each switch for which you have collected data.

Step 6 Continue to collect data on a specific switch by copying the db subfolder from that switch’s folder to the 
pm folder.

Step 7 On the new host, restart the Performance Manager Service (Windows) or Daemon (UNIX). You can use 
the bin/PM.bat file to do this, or you can choose Performance > Collector > Restart from the Fabric 
Manager menu.

Step 8 Re-import the enclosures on the new host.

Step 9 Be sure to turn off the original service on the old host.

Are there restrictions when using Fabric Manager across FCIP?
Fabric Manager will work with no restriction across an FCIP tunnel, as long as the tunnel is up. However, 
Fabric Manager cannot automatically discover a Cisco SN5428 mgmt IP address in the fabric. For that 
switch, it will display a red slash through an FCIP device because of a timeout error. It will still see all 
targets, initiators, and ISLs attached to a Cisco SN5428 (or any other switch) as long as they appear in 
the name server or FSPF.

To work around this, you can manually enter the IP address in the Switches table, and click Apply. If the 
community string is correct, the red slash will go away. Even if the community string is incorrect, 
double-clicking on the Cisco SN5428 will launch the web tool.

How do I fix a "Please insure that FM server is running on localhost" message?
You may see this error message if you cannot connect to the fabric and your PC has multiple network 
interface cards. The problem may be that Fabric Manager is trying to communicate through the wrong 
interface (you can verify this by checking the FMServer.log file).
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Generally it is best to let Fabric Manager choose the interface on startup. If you are getting the above 
error, something may have gone wrong. 

To reset Fabric Manager so that it chooses the interface next time it starts, follow these steps:

Step 1 Open the server.properties file in the Fabric Manager installation directory. On a Windows platform, this 
file is in C:\Program Files\Cisco Systems\MDS 9000 by default.

Step 2 Comment out the line: snmp.localaddress.

Step 3 Save and exit the file.

Step 4 Restart Fabric Manager.

Note There are some cases where you would not want to do this, and should manually select the interface that 
Fabric Manager uses. For more information, see the“How do I run Cisco Fabric Manager with multiple 
interfaces?” section on page 13-20.

How do I run Cisco Fabric Manager with multiple interfaces?
If your PC has multiple interfaces (NICs), the four Cisco Fabric Manager applications detect these 
interfaces automatically (ignoring loopback interfaces). Fabric Manager Client and Device Manager 
detect all interfaces on your PC each time you launch them, and allow you to select one. Fabric Manager 
Server and Performance Manager detect on initial install, and allows you to select one. You are not 
prompted again to choose an interface with these two applications.

There may be circumstances where you will want to change the interface you are using. For example:

• If you add an interface after you have installed Fabric Manager Server and/or Performance Manager

• If you decide to use a different interface than the one you initially selected

• If for any reason one of the Cisco Fabric Manager applications did not detect multiple interfaces

Refer to the following sections, depending on which application you want to recognize the interface.

• Manually specifying an interface for Fabric Manager Server, page 13-20

• Manually specifying an interface for Fabric Manager Client or Device Manager, page 13-21

Manually specifying an interface for Fabric Manager Server

To specify an interface for Fabric Manager Server (including Performance Manager and Fabric Manager 
Web Services), follow these steps:

Step 1 Go to the MDS 9000 folder. On a Windows platform, this folder is at C:\Program Files\Cisco 
Systems\MDS 9000 by default.

Step 2 Edit the server.properties file with a text editor.

Step 3 Scroll until you find the line: snmp.localaddress.

Step 4 If the line is commented, remove the comment character.

Step 5 Set the local address value to the IP address or interface name of the NIC you want to use.
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Step 6 Save the file.

Step 7 Stop and restart Fabric Manager Server.

Manually specifying an interface for Fabric Manager Client or Device Manager

To specify an interface for the Fabric Manager Client or Device Manager, follow these steps:

Step 1 Go to the MDS 9000/bin folder. On a Windows platform, this folder is at C:\Program Files\Cisco 
Systems\MDS 9000 by default.

Step 2 Edit the DeviceManager.bat file or the FabricManager.bat file.

Step 3 Scroll to the line that begins with set JVMARGS=

Step 4 Add the parameter -Device Managerds.nmsaddress=ADDRESS, where ADDRESS is the IP address or 
interface name of the NIC you want to use.

Step 5 Save the file and relaunch Fabric Manager Client or Device Manager.

How do I configure an HTTP proxy server?
If your network uses a proxy server for HTTP requests, make sure the Java Web Start Application 
Manager is properly configured with the IP address of your proxy server.

To configure a proxy server in the Java Web Start Application Manager, follow these steps:

Step 1 Launch the Java Web Start application.

Step 2 Choose File > Preferences from the Java WebStart Application Manager.

Step 3 Choose the Manual radio button and enter the IP address of the proxy server in the HTTP Proxy field.

Step 4 Enter the HTTP port number used by your proxy service in the HTTP Port field.

Step 5 Click OK.

How do I clear the topology map?
If you have a switch that you have removed from the fabric, there will be a red X through the switch’s 
icon. You can clear this information from the Fabric Manager client, or from the Fabric Manager server 
(which will clear the information for all clients) without having to reboot the switch.

To clear information from topology maps using Fabric Manager, follow these steps:

Step 1 Click the Refresh Map icon in the Fabric pane.

This clears the information from the client.

Step 2 Click Purge Down Elements in the Server menu.

This clears the information from the server.
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Caution Any devices not currently accessible (may be offline) are purged.

How can I use Fabric Manager in a mixed software environment?
You can use Fabric Manager version 2.0(x) to manage a mixed fabric of Cisco MDS 9000 switches. 
Certain 2.0 feature tabs will be empty for any switches running a software version that does not support 
those features.

How do I fix a "corrupted jar file" error when launching Fabric Manager?
If you get the following error: 

An error occurred while launching the application Fabric Manager.

download error:corrupted jar file at <ipaddress>\Device Managerboot.jar

(Where <ipaddress>  is that of the switch)

The error message you are getting indicates that the Java Web Start cache is corrupted. You can try 
clearing your Java Web Start cache first. To clear the Cache either run Java Web Start (from the Programs 
menu) and under the preferences select clear cache. Or do it manually by first making sure all Fabric 
Manager or Device Manager instances are closed and then deleting .javaws/cache. In the newer JREs this 
directory is created under Documents and Settings\USERNAME and in the older ones it used to be under 
Program Files\Java Web Start.

You can also browse beneath the cache folder and delete the offending IPAddress folder (e.g. 
cache/http/D10.0.0.1).

Also, check to make sure that the host is not running a virus checker / java blocker?

You also can run the uninstall program and delete .cisco_mds directory, and then reinstall Fabric 
Manager.

How do I search for devices in a fabric?
In Fabric Manager, you can search for one or more devices by different attributes, including pWWN. 

To perform a search in Fabric Manager, follow these steps:

Step 1 Right-click the map and choose Find Elements from the drop-down menu. 

You see the Find Fabric dialog box as shown in Figure 13-1.

Step 2 Choose End Device from the left drop-down list.

Step 3 Choose Port WWN from the right drop-down list.

You can also enter only part of the WWN and use a wildcard (*) character (for example, you can enter 
*fb*f8).
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Figure 13-1 Find Fabric Dialog Box with End Device and Port WWN Selected

Step 4 Click Find in Map.

To search for devices in a zone, click Find in Zones. You see the device highlighted in the Fabric pane. 
Right-click any device to see the attributes for that device. You can also select a link leading to a device 
to see the attributes for the link.

How do I search in a table?
In Fabric Manager, you can search for devices having one or more attributes. You can enter a search 
string in the Find dialog box and then use Next and Previous buttons to navigate through the results. 

To perform a search inside a table in Fabric Manager, follow these steps:

Step 1 Click the Find icon from the tool bar.

You see the Find dialog box as shown in Figure 13-2.

Figure 13-2 Find Dialog Box

Step 2 Enter the search string in the Find text box.
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Step 3 Click Selection to search in selected row(s).

Step 4 Check Ignore Case to ignore case sensitivity.

Step 5 Check Exact Match to search for the data value exactly matching the search string.

Step 6 Click Next to search.

Step 7 Click Cancel to close the dialog box.

How does Fabric Manager Server licensing work?
You must install a Cisco MDS 9000 Family Cisco Fabric Manager Server package on at least one switch 
in each fabric where you intend to manage switches, if you intend to use the enhanced management 
capabilities the license package provides. You must also license all switches you plan to monitor with 
the Performance Manager (historical performance monitoring) feature. Failure to license all switches 
can prevent effective use of the Flow performance monitoring, so it is recommended to license all 
switches in each fabric managed by Cisco Fabric Manager Server.

You are free to try Cisco Fabric Manager Server capabilities prior to installing a license, but the those 
extended functions will stop working after the 120-day grace period expires. Standard Cisco Fabric 
Manager configuration and management capabilities will continue to be accessible without any licensed 
switches after the grace period expires.

How do I manage multiple fabrics?
To monitor and manage multiple fabrics, you must persist one or more fabrics. Do this by checking the 
Persist checkbox on the Server>Admin dialog Fabric tab. You must also use switches running SAN-OS 
Release 1.3.x or later in both fabrics, and you must use the same user/password on both fabrics. Both 
fabrics must not be physically connected.

How can I clear an orange X through a switch caused by license expiration?
If you are using a licensed feature and that license is allowed to expire, Fabric Manager shows a license 
violation, and an orange X is placed through the switch on the Fabric Manager map.

To clear the license violation message and the orange X, stop the Cisco Fabric Manager service on the 
host, and restart it again.
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